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DTS Workflow Overview For Workflow Managers 
DTS Workflow is a tool for creating and designating assignments related to reviewing 
and editing concepts/terms using the DTS Editor.  DTS Workflow is enabled through 
installation of two DTS Workflow plugins, DTS Workflow Server and DTS Workflow 
Client. 

The Workflow Manager creates assignments that consist of concepts and/or terms for 
review and possible edit.  The Manager then designates a Modeler to review each 
assignment (another Manager also may be designated to review and edit the assignment 
concepts).  Only those assignments assigned to a Modeler by the Manager appear in the 
Modeler’s assignment view.   

The Modeler can accept the tasks of reviewing and editing the concepts/terms in an 
assignment.  The Modeler uses the standard DTS Editor create, edit, and delete functions 
to make necessary concept/term modifications.   

Assignment edits to non-editable (e.g., subscription) namespaces are written to the local 
namespace selected by the Modeler.  The namespace is updated with the Modeler edits as 
soon as the Modeler saves the edits.   

The Modeler then can mark the assignment as COMPLETED (even if no action was 
taken for some of the concepts/terms in the assignment) or INCOMPLETE.  The 
Manager can view completed assignments, and view the edits performed by the Modeler 
in detail.  The Manager then can decide if any portion of the completed assignment 
requires further attention by either a Modeler or a Manager. 

Note: Because assignment edits are immediate (upon save) you should set up a DTS 
Server for content editing that is separate from the one you use for production.  After you 
complete a body of work using DTS Workflow, you can publish local namespace content 
using the DTS publishing utility, then load it onto your production DTS Server.   
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Install and Set Up DTS Workflow  
The procedures discussed in the DTS Workflow Manager Users Guide assume that you 
have installed Apelon DTS (including the DTS Editor component) along with the DTS 
Workflow plugins, DTS Workflow Server and DTS Workflow Client.  (Note that the 
servers (DTS Server and Workflow Server) and clients (DTS Editor and Workflow 
Client) may be installed on different machines.)  Without the installed plugins, you 
cannot use the DTS Workflow features in the DTS Editor or the User Manager. 

Install DTS Workflow Plugins  
The DTS Workflow Server module installs the configuration and batch files required to 
create the DTSWF schema, and updates the User Manager to assign Workflow 
Manager and Modeler roles.  When the DTS Workflow Client module is installed, the 
data entry and administration panels required to create and maintain work assignments 
are added to the available DTS Editor functions. 

1. Download and save the current version of Apelon DTS Workflow Server to a 
local drive on your Windows PC where the DTS Server Administration 
component has been installed.  

2. Click the DTS Workflow Server link to run the InstallShield wizard, which 
guides you through the installation process; when the Install Complete window 
displays, click Finish. 

3. Download and save the current version of Apelon DTS Workflow Client to a 
local drive on your Windows PC where the DTS Editor component has been 
installed.    

4. Click the DTS Workflow Client link to run the InstallShield wizard, which 
guides you through the installation process; when the Install Complete window 
displays, click Finish. 

Assignment Query Server and Version Query Server 
Before you can use DTS Workflow, you must uncomment out both the Assignment 
Query Server and the Version Query Server located near the end of the 
apelonserverprops.xml file (DTS 3.4\bin\server) on the DTS Server machine.  These 
servers retrieve data from the workflow database tables.   
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<queryserver> 
    <property name="qs" value="com.apelon.dtswf.server.VersionServer" /> 
    <property name="maxDbConns" value="15" /> 
    <property name="header" value="DWF:001" /> 
  </queryserver> 

 <queryserver> 
    <property name="qs" value="com.apelon.dtswf.server.AssignmentServer" /> 
    <property name="maxDbConns" value="15" /> 
    <property name="header" value="DWF:002" /> 
 </queryserver> 
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When you log into DTS Editor with Workflow, you must connect to the DTS Server 
using a Secure Socket Server Connection with user authentication.  In the 
apelonserverprops.xml file, set the authentication property to true to permit users to 
log in (with password) to a secure socket connection with the Apelon DTS Server.   

         <property name="authentication" value="true"/> 

Create DTS Workflow Schema 
Follow this procedure to configure and create the DTS Workflow schema. 

1. When you install Apelon DTS with the DTS Workflow Server plugin, a dtswf 
subdirectory is created in DTS 3.4\bin.   
 
In the dtswfkbcreate.xml file in DTS 3.4\bin\dtswf, ensure that the DTS 
Knowledgebase connection parameters are identical to those established in the 
apelonserverprops.xml file (DTS 3.4\bin\server).  The dtswfkbcreate.xml file 
is illustrated.  

 

 

 

 

<?xml version="1.0" encoding="UTF-8"?> 
 
<!DOCTYPE DBConfig SYSTEM "http://apelon.com/dtd/util/db/dbconfig.dtd"> 
 <DBConfig> 
  <!-- 
    ################################### 
    #  Database Connection            # 
    ################################### 
  --> 
   <!-- I-Net Sprinta Driver --> 
   <connection> 
    <property name="direction" value="target" />  
    <property name="type" value="sql2k" /> 
     <property name="user" value="sa" /> 
    <property name="pass" value="" /> 
    <property name="host" value="localhost" /> 
    <property name="databaseName" value="dts" /> 
    <property name="databasePort" value="1433" /> 
     <property name="jdbcDriver" value="com.inet.tds.TdsDriver" /> 
    <property name="url_template" 
value="jdbc:inetdae:[HOST]:[PORT]?database=[DATABASE]" /> 
   </connection> 
    
  <!-- Microsoft Driver --> 
  <!-- 
  <connection> 
    <property name="direction" value="target" />  
      <property name="type" value="sql2k" /> 
      <property name="user" value="sa" /> 
      <property name="pass" value="" /> 
      <property name="host" value="localhost" /> 
      <property name="databaseName" value="dts" /> 
      <property name="databasePort" value="1433" /> 
      <property name="jdbcDriver" value="com.microsoft.jdbc.sqlserver.SQLServerDriver" /> 
      <property name="url_template" 
value="jdbc:microsoft:sqlserver://[HOST]:[PORT];databasename=[DATABASE]" /> 
    </connection> 
   -->
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 <!-- Oracle Driver --> 
    <!-- 
    <connection> 
     <property name="type" value="oracle" /> 
      <property name="user" value="dts" /> 
    <property name="pass" value="dts" /> 
    <property name="host" value="localhost" /> 
    <property name="databaseName" value="ORCL" /> 
    <property name="databasePort" value="1521" /> 
    <property name="jdbcDriver" value="oracle.jdbc.driver.OracleDriver" /> 
    <property name="url_template" value="jdbc:oracle:thin:@[HOST]:[PORT]:[DATABASE]" /> 
    </connection>  
    --> 
<!-- 
   If this knowledgebase will be primarily used as a staging database  
   for creating incremental subscriptions, then provide the  
   Master knowledgebase name in the property for masterKb,  
   which has the latest version of vocabularies and against which  
   subscription diff process will be done.  
      This is needed to synchronize the global sequence with one on  
      Master knowledgebase to avoid any IID collisions. 
   Note:  
   - Expects Master knowledgebase to exist in the same database instance 
     as the staging. 
   - If this value is left blank then the numerical value provided  
     in kbcreate.bat switch -startSeq is used to seed the  
     global sequence generator. 

   Example:  
   - For Oracle, its the user name (e.g dts30) 
   - For SQL2000, its the databaseName (e.g dts30.dbo) 
 --> 
 <property name="masterKb" value="" /> 
 
</DBConfig>  

2. To create the DTS Workflow schema, run dtswfcbcreate.bat in DTS 
3.4\bin\dtswf. 
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@echo off 
REM 
REM Process Arguments when connection params are present in properties-file:  
REM -p <properties-file.xml> -c <configuration full-class name> 
REM If no properties-file is specified, default configuration file used -> kbcreate.xml 
 
REM 
REM Process arguments overriding the properties file configuration variables:  
REM (i.e., connection params from a separate file overrides one in the property file): 
REM Usage: -c <system configuration class name> which is mandatory   
REM    -p <user property file name> 
REM  file having the properties needed to run this process 
REM    -skipConstraints (yes/no)  
REM  If yes, the process does not disable/enable constraints and drop/add indexes while updating DTS 
knowledgebase 
REM    -t <target connection config file> 
REM  file with the target connection params.  
REM    -startSeq  
REM  the seed value for the global sequence number (refer documentation before assigning one) 
REM    -skipPause will skip every pause in the process. If the schema already exists, it will override it without 
comfirming. 
REM        -saveDTSSequences will not drop existing sequences 
REM 
 
cd .. 

call runApp_cw 512 com.apelon.common.util.db.DbCreate -c com.apelon.dtswf.db.admin.DTSWFDBCreateConfig -p 
dtswf/dtswfkbcreate.xml -t kb/target-connection.xml -saveDTSSequences 

cd dtswf 

target-connection.xml File 
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A template connection file, target-connection.xml (in DTS 3.4\bin\kb), allows you to 
define a custom connection based on the target connection parameters.  To establish a 
target connection in the target-connection.xml file, the value of the direction property 
should be target.  

                                               <property name="direction" value="target" /> 

You can create multiple versions of the target-connection.xml files, each with its own 
specific name, and each reflecting a specific connection to a data source.  After you 
establish your custom connection parameters in the target-connection. xml file, modify 
the Command Line switch parameter in dtswfcbcreate.bat by specifying the target-
connection.xml file name to reference the appropriate custom configuration file.   

Managing DTS Users for Workflow 
The type of DTS user (Manager or Modeler) who connects to the DTS Server 
determines which Workflow functions (Manager or Modeler) will be available in the 
DTS Editor.  A DTS Manager can create, view, delete, and edit assignments in DTS 
Workflow.  A DTS Modeler can view all assignments, but can perform edits only for 
assignments assigned to that Modeler.  

Whenever you log into DTS Editor with Workflow, you must connect to the DTS Server 
using a Secure Socket Server Connection with user authentication.  This section 
highlights for the System Administrator how to create valid users for DTS Workflow, 
assign and maintain each user’s edit permissions within local namespaces, and designate 
each DTS user as a Workflow Manager or a Modeler.  A GUI-based User Manager tool 
is available from the Windows Start menu to perform user maintenance.   

Use the Remote Server administration tool to modify user information (username and 
password) as necessary.  Refer to the Reset User Information discussion in the DTS 
Server Operations Guide.   

Create User/Assign Namespace Permissions 
Follow this procedure to create a new DTS user, and assign user edit permissions in local 
namespaces.   

1. Select User Manager from the Windows Start menu (Start>Programs> 
Apelon>DTS 3.4>User Manager).  The Apelon DTS User Manager window 
displays.  
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2. At this point you must connect to the DTS database.  Select Connect from the 

Apelon DTS User Manager window File menu.  The Connect to Database 
window displays. 
 

 
3. Enter your Username and Password.  Also specify a Host name for the machine 

where your database is installed.  To recall these values for future sessions, click 
Use these values as defaults.  

4. If your configuration requires you to modify the default Oracle instance and port 
designations, or to choose SQL Server, click on Advanced. The Advanced Setup 
window displays. 
 

 
 
If you choose Oracle – Thin Client Driver in the Database/Driver field, you can 
accept the default database name in the Database name/instance field, and the 
default port number in the Port field, or override the defaults to connect to the 
desired database.  Click OK. 
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 - If you indicated during DTS installation that you maintain your DTS  
    knowledgebase in a Microsoft SQL 2000 Server database, and you have  
    obtained and installed the I-netSPRINTA driver, then SQL Server –  
    Sprinta Driver is included as an option in the Database/Driver field.   
 
 - If you indicated during DTS installation that you maintain your DTS  
    knowledgebase in a Microsoft SQL 2000 Server database, and selected the  
    Microsoft driver that is provided with DTS,  then SQL Server – Microsoft is  
    included as an option in the Database/Driver field.   
 
In the displayed Database/Driver field, specify your SQL Server/driver selection.  
In the displayed Instance field, specify the SQL Server named instance (if you are 
using a default instance, leave the field blank). 

5. Click Connect on the Connect to Database window.  The Apelon DTS User 
Manager window displays again, with Current Users listed. 
 

 
6. Click New.  The Add New User window displays. 

 

 
7. Specify the User Name and Password for the new user (the password displays as 

asterisks).  Retype the new password in the Confirm field (the password displays 
again as asterisks).  
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8. Click OK.  The User Manager window displays again, listing the new user. 

 

 

 

© 1999-2006 Apelon, Inc.  All Rights Reserved. 

9. At this point you can assign local namespace edit permissions for the new user, 
and/or edit permissions for an existing user.  If a Modeler makes edits to a non-
writable (i.e., subscription) namespace as a result of an assignment, those edits are 
written to the local namespace the Modeler selects in the DTS Editor.     
Highlight a username listed under Current Users on the Apelon DTS User 
Manager window, then click Permissions.   
 
The Select Permissions window displays.  The username you selected is listed, as 
well as the local namespaces in your DTS Knowledgebase for which edit 
permissions can be assigned. 
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On this window you can select the local namespace(s) in the DTS 
Knowledgebase for which the user will have edit capability.  

10. For the new or existing user, click each checkbox representing the local 
namespace for which the user will have edit permission.  To remove namespace 
edit permission for a user, click the checkbox adjacent to the listed namespace to 
remove the check mark.  

11. Click OK to create or update the user’s edit permissions in the selected local 
namespaces.  Click Cancel to ignore the new or updated permissions. 

12. Click Close to exit the Apelon DTS User Manager window. 

Change User Password  
Follow this procedure to modify the password for an existing DTS user. 

1. To change an existing user’s password, highlight the username on the Apelon DTS 
User Manager window. 
 

 
2. Click Change Password.  The Change Password window displays. 

 

 
3. Enter the New Password for the user (the password displays as asterisks).  Retype 

the new password in the Confirm field (the password displays again as asterisks).  
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4. Click OK to update the user password.  Click Cancel to ignore the modification. 

5. Click Close to exit the Apelon DTS User Manager window. 

Delete DTS User  
Follow this procedure to delete an existing DTS user. 

1. To delete an existing DTS user, highlight the username on the Apelon DTS User 
Manager window. 
 

 
2. Click Delete.  The following confirmation window displays. 

 

 
3. Click Cancel to ignore the deletion.  Click OK to delete the username from the 

list of Current Users on the Apelon DTS User Manager window. 

4. Click Close to exit the Apelon DTS User Manager window. 

 

© 1999-2006 Apelon, Inc.  All Rights Reserved. 

  Page 13 of 67 



Assign Workflow Role to a User 
Follow this procedure to designate a user as a DTS Workflow Manager or Modeler. 

1. To designate a user as a Manager or Modeler for DTS Workflow, highlight the 
username on the Apelon DTS User Manager window. 
 

 
2. Click Assign Workflow Role.  The Assign Workflow Role window displays. 

 

 
 
The name of the user for whom you are designating a Workflow role is indicated. 

3. Click on Manager or Modeler, as appropriate (the default is Modeler).  For this 
illustration, Manager is selected. 
 

 
 
A DTS Workflow Manager can create, edit, and delete assignments, assign those 
assignments to Modelers or other Managers, and view/edit assignments created by 
all other Managers.  The Manager also can use the DTS Editor to perform edits on 
the concepts/terms in the assignments.   
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A DTS Workflow Modeler cannot create assignments, or assign assignments to 
Modelers or Managers.  A Modeler can view all assignments, but can edit only 
those assignments assigned to that Modeler by a DTS Manager, then perform 
necessary edits to concepts or terms (driven by the assignment) using the DTS 
Editor.  

4. Click OK.  The Apelon DTS User Manager window reflects the assigned role 
type in the Role Type panel. 
 

 
5. Click Close to exit the Apelon DTS User Manager window. 
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Start DTS Editor With DTS Workflow 

Connection and Logon 
Before you connect to the DTS Server, confirm that the DTS user has been created with 
the appropriate namespace permissions and role type (i.e., Manager or Modeler) using 
the DTS User Manager tool.  Refer to the Managing DTS Users for Workflow 
discussions for procedures on adding and maintaining DTS users for Workflow. 

Follow the procedure highlighted in this section to establish a connection to the server 
where your DTS knowledgebase resides.  Because the type of user (Manager or 
Modeler) who connects to the DTS Server determines which Workflow functions will be 
available through the DTS Editor, each user must connect to the DTS Server using a 
Secure Socket Server Connection with user authentication.     

1. Ensure that the Apelon DTS Server is running, either on your machine or the 
machine where it was installed.  Start the DTS Server on your machine by 
selecting Start Apelon DTS Server from the Windows start menu (Start> 
Programs>Apelon>DTS 3.4>Start Apelon DTS Server). 

2. Start the DTS Editor from the Windows Start menu (Start>Programs>Apelon> 
DTS 3.4>Apelon DTS Editor).  If there is a shortcut for the DTS Editor, click 
the shortcut icon.  The DTS Editor Main window displays.  
 

 
 
If you performed the DTS Workflow Client plugin installation, the Workflow 
tabs, Assignment List and Audit, are included in the window. 
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3. At this point you must specify the required connection to the DTS server.  Select 
Connect Options from the File menu.  When the Connect Options window 
displays, click on the dropdown field to display the available connection options. 
 

 
4. Select Secure Socket Server Connection from the Connect Type Option 

dropdown field, then click OK.  The Connect to Apelon Server window displays. 
 

 
5. Enter your Host name (for the machine where your DTS Server is running) and 

Port number to access the DTS Server.  Since the secure socket connection 
requires user authentication, also specify your valid Username and Password.  To 
recall these values for future sessions, click Use these values as defaults.  
 
If the Username you specified was established with the DTS Modeler role type, 
only the DTS Workflow Modeler functions will be available using the DTS 
Editor.  If the Username was established with the Manager role type, all DTS 
Workflow functions (Modeler and Manager functions) will be available in the 
DTS Editor.  

6. Click Connect to establish the secure socket server connection to your DTS 
Server.   
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Workflow Manager – View, Create, Edit, and Delete Assignments 
An assignment is a list of knowledgebase items (i.e., concepts or terms) that the DTS 
Workflow Manager creates from one or more namespaces.  In the opinion of the 
Workflow Manager, each item in the assignment requires review and possible edit by a 
DTS Workflow Modeler (or, a Workflow Manager acting in the Modeler role).  

The Modeler selected for the assignment by the Manager then reviews each assignment 
item.  The Modeler can choose to accept the tasks of evaluating the concepts/terms in the 
assignment, then perform the required concept edits and/or additions, as needed.  
Concept/term edits made by the Modeler are updated into the namespace immediately.    

The Modeler marks the assignment as complete when he/she is sure no further reviews or 
edits are needed.  If the Modeler thinks additional review or action is required, he/she can 
mark the assignment as incomplete.  The Manager then reviews the assignment and 
associated edits, and determines if additional action is needed for any of the concept/term 
items in the assignment. 

Assignment List Panel 
The Manager performs all activity related to creating, editing, and designating 
assignments on the Assignment List panel.  The Manager creates a new assignment for 
Modeler review, and can view, edit, or delete an existing assignment.   

The Manager also determines if further action is required on any of the assignment 
concept/term items based on edits made by the assigned Modeler.  A series of filters and 
sort options allows the Manager to customize assignment lists to display only the most 
relevant information.  

Click the Assignment List tab on the DTS Editor Main window.  The Assignment List 
panel displays, listing assignments in a table format.  The panel resembles the following 
if a Manager login username was used to connect to the DTS Server. 
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You can resize the Assignment List panel, as desired.   
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View Existing Assignment List 
When you click the Assignment List tab, the default Assignment List panel Filter is My 
Worklist.  Only those assignments that you assigned as Manager that have not been 
approved (i.e., Modeler edits have not been approved by a Manager) are listed when My 
Worklist is the selected filter.   

 
 
The following information is listed for each assignment when the panel opens.  If the 
information displayed in a cell is truncated, position the cursor over that cell to produce a 
tooltip window that displays the complete contents of the cell.   

ID – The assignment ID, created automatically by DTS Workflow when the 
Manager creates the assignment 

Name – The assignment name (e.g., description) specified by the Manager on 
creation of the assignment 

Modeler – The username of the Modeler who will review assignment items and 
edit concepts/terms.  The Manager can select a Modeler during  assignment 
creation (the status is set to ASSIGNED) or at a later time (the Modeler column 
in the Assignment List table is left blank, and the status is UNASSIGNED).  Any 
Manager can assign a Modeler for an assignment that is UNASSIGNED. 

Manager – The current Manager of the assignment (i.e., the Manager who most 
recently assigned the assignment to a Modeler).  This Manager can be different 
from the one who created the assignment; if the assignment was not assigned, no 
Manager username is indicated 

Assigned – The date and time the Manager designated the assignment to a 
Modeler. 

Status – The current status of the assignment 

• UNASSIGNED – The Manager created the assignment, but did not select a 
Modeler to review or edit it 

o Only a Manager can create an assignment with UNASSIGNED status 

o Only a Manager can change an UNASSIGNED assignment to 
ASSIGNED  

• ASSIGNED – The Manager selected a Modeler to review the assignment and 
make required edits 

 

© 1999-2006 Apelon, Inc.  All Rights Reserved. 

  Page 20 of 67 



o Only a Manager can change an ASSIGNED assignment to 
UNASSIGNED, then assign it to another Modeler 

o A Modeler can change an ASSIGNED status to ACCEPTED (to agree to 
perform edits) or DECLINED (to decline to perform edits) 

• ACCEPTED – The Modeler has seen the assignment, and has accepted the 
tasks of reviewing the items within and making necessary edits   

o Only a Manager can change the ACCEPTED status to UNASSIGNED, 
then assign it to a different Modeler 

o A Modeler can change the ACCEPTED status to COMPLETED when 
all edits are finished, or to INCOMPLETE if only some edits could be 
completed 

• DECLINED – The Modeler has seen the assignment, and has declined the 
task of reviewing the items within and making necessary edits.  A Manager 
can change the DECLINED status to UNASSIGNED, then assign the 
assignment to another Modeler. 

• INCOMPLETE – The Modeler has reviewed the items in the assignment and 
performed edits on some of them, but not all, and has marked the assignment 
as incomplete 

o Only a Manager can change an INCOMPLETE assignment to 
UNASSIGNED, then assign it to another Modeler 

o Only a Manager can change an INCOMPLETE assignment to 
REJECTED to reject the incomplete edits 

o Only a Manager can change an INCOMPLETE assignment to 
APPROVED to approve the edits 

• COMPLETED – The Modeler has reviewed the items in the assignment and 
performed all necessary edits, and has marked the assignment as complete 

o Only a Manager can change a COMPLETED assignment to 
UNASSIGNED, then assign it to another Modeler 

o Only a Manager can change a COMPLETED assignment to REJECTED 
to reject the edits 

o Only a Manager can change a COMPLETED assignment to 
APPROVED to approve the completed edits 

• REJECTED – The Manager has rejected the Modeler edits for a completed 
or incomplete assignment 

o Only a Manager can change a REJECTED assignment to 
UNASSIGNED, then assign it to another Modeler 
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o Only a Manager can change a REJECTED assignment to COMPLETED 
(e.g., if it was rejected accidentally) 

o Only a Manager can change a REJECTED assignment to 
INCOMPLETE (e.g., if it was rejected accidentally) 

o Only a Manager can change a REJECTED assignment to APPROVED 
to approve the completed edits 

o A Modeler can change a REJECTED assignment to ACCEPTED (to 
agree to perform edits) or DECLINED (to decline to perform edits) 

• APPROVED – The Manager has approved the Modeler edits for a completed 
or incomplete assignment 

o Only a Manager can change an APPROVED assignment to REJECTED 
(e.g., if it was approved accidentally) 

o Only a Manager can change an APPROVED assignment to 
COMPLETED (e.g., if it was approved accidentally) 

o Only a Manager can change an APPROVED assignment to 
INCOMPLETE (e.g., if it was approved accidentally) 

o Only a Manager can change an APPROVED assignment to 
UNASSIGNED, then assign it to another Modeler  for rework 

The following illustration indicates status edit privileges for Managers and 
Modelers. 
 

Modeler can
Accept or Decline
the assignment

Manager can assign
a new or existing
assignment  to a

Modeler

UNASSIGNED

ASSIGNED

DECLINED ACCEPTED

COMPLETE INCOMPLETE

APPROVEDREJECTED

Modeler can mark
the assignment as

Complete, or
Incomplete

Manager can Approve
assignment edits, or
mark assignment as

Rejected

Manager can reset
Incomplete, Accepted,  or
Approved assignment to

UnassignedManager can reset
Complete or Rejected

assignment to
Unassigned
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Status Date – The date and time the assignment status last changed 

Created By – The Manager who created the assignment 

Created – The date and time the assignment was created by the Manager 

Due – The date and time the Manager expects completion of the assignment by 
the designated Modeler.  If the Manager did not specify a due date for the 
assignment, the assignment creation date and time are the defaults. 

Modified – The date and time the assignment was last modified (whether or not 
the assignment status changed as a result) 

Filter Assignment List 
To filter the list to view only those assignments that interest you, click the Filter field 
dropdown arrow.  The filter options are listed. 

• My Worklist - Assignments assigned by the Manager that are not 
APPROVED 

• My Assignments - Assignments created by the Manager that are not 
APPROVED 

• My Worklist As Modeler - Assignments assigned to the Modeler that are 
ASSIGNED, ACCEPTED, or REJECTED 

• All Last 7 Days - Assignments that have had a status update in last 7 days 

• All Last 30 Days - Assignments that have had a status update in the last 30 
days 

• All Unassigned - All assignments with UNASSIGNED status 

• All Assigned - All assignments with ASSIGNED status 

• All Accepted - All assignments with ACCEPTED status 

• All Declined - All assignments with DECLINED status 

• All Completed - All assignments with COMPLETED status 

• All Incomplete - All assignments with INCOMPLETE status 

• All Rejected - All assignments with REJECTED status 

• All Approved - All assignments with APPROVED status 

• All - All assignments (no filter) 
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Customize Assignment List Table Layout  
You can reposition the Assignment List table columns by dragging/dropping the column 
headers into their new positions.  You also can resize each column, as needed (note the 
illustration).  The column position and size settings are retained throughout the current 
session.    

   
You can resort the table data by clicking the desired (sort) header once.  The first click 
sorts the table in ascending order; the second click sorts in descending order.  Click the 
column header a third time to remove the sort.  You can establish a secondary sort by 
pressing the Control key, then clicking the secondary sort column.    

View Assignment Detail 
Follow this procedure to view details for each individual assignment listed in the 
Assignment List table.  

1. Click the assignment in the Assignment List table to highlight it, then click the 
View Assignment button in the Assignment List panel toolbar. 
 
 
 

 
 
The lower portion of the Assignment List panel displays details for the assignment 
you selected.  Note the tab at the bottom of the display indicates the number of the 
assignment, and also that the assignment is in View mode.  
 

View Assignment Button 
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None of the assignment detail is editable in View mode; all fields are disabled for 
edit.  Click the Edit Assignment button to perform edits on the selected concept. 
 
The following assignment detail is listed in View mode. 

• Name – A brief description of the assignment, entered by the Manager 
when the assignment was created, or modified subsequently by a Manager. 

• Due Date – The expected completion date for the assignment, entered by 
the Manager when the assignment was created, or modified subsequently 
by a Manager. 

• Assigned To – The DTS user (i.e., Modeler) to whom the Manager issued 
this assignment when the assignment was created, or when the assignment 
was modified subsequently by a Manager.   

• Status – The current status of the assignment. 

• Created – The date the Manager created the assignment.  

• Assigned By – The Manager who designated the Modeler for this 
assignment (this can be a Manager other than the one who created the 
assignment). 
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2. Ensure the Details tab is selected to list the items that reference the 
concepts/terms the Manager selected for review and/or edit by the Modeler.  
Assignment items are listed in table format in the lower portion of the panel.   
 
The following detail is included for each concept/term item in the assignment. 

• Complete – If the checkbox is checked, it indicates that the Modeler has 
reviewed this individual item, completed necessary edits, and marked this 
individual item as COMPLETE 

• Type – The type of namespace item for review and/or edit by the Modeler, 
Concept or Term 

• Name – The name of the concept or term the Manager selected for 
Modeler review or edit 

• ID – The concept or term ID 

• Code – The concept or term code 

• Namespace – The namespace from which the Manager selected the 
concept or term to be reviewed or edited.  Concepts and terms from 
multiple namespaces can be included in the same assignment. 

• Added By – The Manager who added the concept/term item (this can be a 
Manager other than the one who created the assignment) 

• Notes – The Manager can enter a note (e.g., review or edit instructions) 
for each individual concept/term item in the assignment when the 
assignment is created.  Any Manager can enter notes for individual items 
during subsequent edit of the assignment.   
 
Each individual assignment note can be up to 1024 characters..If the note 
text in the cell is truncated, position the cursor over that cell to display a 
tooltip window that includes the complete text of the note.   

Note that if the detailed information displayed in any cell is truncated, you can 
position the cursor over that cell to produce a tooltip window that displays the 
complete contents of the cell.  You also can reposition the assignment items table 
columns by dragging/dropping the column headers into their new positions, 
and/or resize each column, as needed.        
 
You also can resort the table data by clicking the desired (sort) header once.  The 
first click sorts the table in ascending order; the second click sorts in descending 
order.  Click the column header a third time to remove the sort.  You can establish 
a secondary sort by pressing the Control key, then clicking the secondary sort 
column.    
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3. The Manager who creates the assignment has the option to create notes regarding 
the assignment.  Any Manager also may enter additional notes after the 
assignment is created (i.e., when the assignment is opened in Edit mode).  To 
view notes related to the entire assignment, click the Notes tab.  All notes entered 
for the assignment are listed in the notes display area. 
 

 
In addition to the note text, each note includes the date and time the note was 
created.  You can restrict the display to a single note for the assignment by 
selecting the username and time stamp for the note from the Note By field 
dropdown list.  

4. Click the Details tab to redisplay the assignment detail.   

5. Click Close to close the detail portion of the Assignment List panel.  This  
indicator tab (View Assignment #nn) remains displayed in the bottom portion of 
the window until you close the assignment view. 
 
At this point you can select another assignment from the Assignment List panel 
table, or click any other indicator tab (View Assignment, Edit Assignment, etc.) 
at the bottom of the display to resume that function.  

Create an Assignment for a Modeler 
Follow this procedure to create a new assignment for review and/or edit by a modeler, or 
by another Manager.  

1. To create a new assignment for a Modeler, click the New Assignment button in 
the Assignment List panel toolbar. 
 
 
 

 
 
The lower portion of the panel displays fields for the entry of information for the 
new assignment; note that the Details tab on the panel is selected as the default.  
An indicator at the bottom of the panel designates New Assignment.  
 

New Assignment Button
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2. Enter a brief description of the assignment in the Name field. 

3. In the Due Date field you can specify the expected completion date for the 
assignment.  You can specify the due date in the format shown, or you can click 
the drop arrow adjacent to the field to display a calendar for date selection. 
 

 
 
Select the year and month from the appropriate field dropdown lists, then click the 
due date on the displayed calendar.  The date you select displays in the Due Date 
field on the Assignment List panel. 

4. From the Assigned To field dropdown list, select the DTS user (i.e., a Modeler, or 
another Manager) to whom you are issuing this assignment.  All established DTS 
Workflow users are included in the list (both Modelers and Managers).  Refer to 
the Managing DTS Users for Workflow discussions earlier in the guide for 
procedures on creating and maintaining DTS users who use Workflow.  
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When you select a Modeler for the assignment, the assignment status changes to 
ASSIGNED.  If you do not select a Modeler, the assignment status remains as 
UNASSIGNED (you can save the new assignment with an UNASSIGNED 
status, then you, or another Manager, can edit the assignment and assign the 
Modeler at a later time).  

5. You have the option of entering notes that pertain to the entire assignment.  Click 
the Notes tab, then click the New button that displays subsequently.  The Enter 
Notes window displays. 
 

 
 
Enter the note you want associated with the assignment, then click OK.  The note 
is listed in the display area on the Notes tab.  
 

 
 
Click the Details tab to redisplay the assignment detail. 

6. At this point you can select the concepts that are to be reviewed and/or edited by 
the selected Modeler for this assignment.  From the Concept Tree, Concept 
Walker, or Search panel, drag each concept you want to add and drop it into the 
lower portion of the Assignment List panel.  Each assignment item displays in a 
table format. 
 
Note the following illustration, where individual concepts were selected from the 
Concept Tree and Search windows. 
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For each concept you drag into the Assignment List panel, the concept Type, 
Name, and Namespace are listed.  (The Complete checkbox is an indicator that 
designates if the Modeler has completed editing the concept/term in the 
assignment.) 
 
For each item you can reposition the columns by dragging/dropping the column 
headers into their new positions.  You also can resize each column, as needed 
(note the illustration).        
 

 
 
Using standard Windows selection procedures, you also can select multiple items 
(i.e., concepts or terms) from another displayed panel (e.g., the Search panel) and 
drop them into the Assignment List panel.  Note the illustration, in which several 
items from the Search panel were selected and dropped into the Assignment List 
panel. 
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7. You can resort the table data by clicking the desired (sort) header once.  The first 

click sorts the table in ascending order, the second sorts in descending order; click 
the header a third time to remove the sort.  You can establish a secondary sort by 
pressing the Control key, then clicking the secondary sort column.       

8. You can enter note text (e.g., instructions to the Modeler regarding the review or 
edit that is required) for each individual concept/term item when the assignment 
is created.  Any Manager also can enter note text during subsequent edit of the 
assignment.   
 
To enter note text for a line item, enter the desired text in the Notes column field 
on the desired line. 
 

 
9. After you complete entry of assignment information, click OK.  The detail 

portion of the Assignment List panel is cleared, and the new assignment is added 
to the assignment list table in the top portion of the panel.  Note the highlighted 
line in the illustration. 
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Note that you can click the Refresh Assignment List option in the Tools menu at 
any time to update the assignment list table. 

10. If you selected a Modeler for the assignment, the assignment status is 
ASSIGNED, and the Modeler is reflected in the Modeler column.  When the 
Modeler logs into DTS Workflow, this assignment will be listed with any others 
assigned to the Modeler.   
 
If you designated a Modeler to review the assignment for edits (or to another 
Manager acting in the role of a Modeler) the assignment can be retrieved and 
viewed by that individual.  Refer to the Modeler – Review Assignments and 
Perform Concept Edits discussion for procedures on performing concept edits 
from the assignment, and updating the assignment status subsequently. 

Edit an Assignment 
As a Manager, you can edit any assignment.  The degree of edit capability available 
depends on the status of the assignment.  A status of UNASSIGNED offers the greatest 
degree of edit capability.  If the assignment is APPROVED, only the assignment Status 
can be modified (however, the status can be set to UNASSIGNED to provide more 
editing flexibility).    
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1. In the listing of assignments on the Assignment List panel, double-click the 
assignment you want to edit, or click the assignment to highlight it, then click the 
Edit Assignment button in the Assignment List panel toolbar. 
 
 

 
 
Another way to open the assignment in Edit mode is to select Go To Assignment 
from the Tools menu.  The following window displays. 
 

 

Edit Assignment Button
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Enter the ID number of the assignment you want to edit, then click OK. 
 
Note that if the Modeler, or another Manager, has the assignment opened in Edit 
mode, a lock is placed on the assignment to prevent edit conflicts.  A window 
similar to the following displays to indicate who has the assignment open in Edit 
mode, and the time the assignment was locked. 
  

 
 
You have the option of viewing the assignment, or unlocking it.  Refer to the 
Unlock an Assignment discussion.  
 
If the assignment is not locked, it is available for edit.  The lower portion of the 
panel displays details for the assignment you selected. 
 

 
 
The tab at the bottom of the Assignment List panel indicates the number of the 
assignment, and also that the assignment is in Edit mode.  
 
In the detail portion of the panel, the date the assignment was Created is listed, as 
well as the Manager who assigned the assignment to the Modeler (in the Assigned 
By field).  These fields are for reference only.  
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2. Modify the assignment Name and Due Date, as necessary.   

3. When a Modeler is designated for an assignment, the Assigned To field reflects 
the name of the Modeler, and the assignment Status is set to ASSIGNED.  If a 
Modeler was assigned, the Assigned To field is disabled. 
 
In order to designate another Modeler for the assignment, you must change the 
Status to UNASSIGNED, then save the assignment (click Apply).  The Assigned 
To field is reset to <NOT SET>.  You then can select another Modeler from the 
Assigned To field pulldown list; when you save the assignment again, the Status is 
updated to ASSIGNED.     
 
If the assignment Status is COMPLETED (indicating that the Modeler has 
completed the assignment reviews and edits) you can change the assignment 
status to APPROVED or REJECTED. 

4. The Manager who creates the assignment has the option to create notes regarding 
the entire assignment.  Any Manager also may enter additional notes after the 
assignment is created.  To add additional notes for the assignment, click the Notes 
tab, then click the New button that displays subsequently.  The Enter Notes 
window displays. 
 

 
 
Enter the new note you want associated with the assignment, then click OK.  The 
new note is listed in the display area on the Notes tab.  
 
Click the Details tab to redisplay the assignment detail information.   

5. You also can enter note text for each individual concept/term item in the 
assignment (e.g., details to the Manager regarding the edits performed).  To enter 
note text for a line, enter the text in the Notes column field on the desired line. 
 

 
 
Any Manager can perform all of the assignment tasks that a Modeler can perform.  
These tasks include edits driven by an assignment.  If edits are completed for an 
individual item, you can update the status of each individual item in the 
assignment item table as COMPLETE by clicking the Complete checkbox. 
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You also can right-click anywhere on the individual item, then click Mark 
Complete when the resulting options display to update the item status as 
COMPLETE.  A check mark is inserted in the Complete checkbox. 
 

 
 
If one or more completed items require additional review and/or edit, click Mark 
Incomplete for the highlighted items (use standard Windows selection procedures 
to select and highlight the lines).  The following window displays.  
 

 
 
Click OK.  The check is removed from the Complete checkbox for the item(s).  

6. A Modeler can delete only items that he/she has added (not those assigned by a 
Manager).  To delete one or more items (whether marked as completed or not) 
click Delete for the highlighted items (use standard Windows selection procedures 
to select and highlight the lines).  The following window displays   
  

 
 
Click OK to confirm deletion of the item(s) from the assignment. 
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7. Click OK to update the assignment with your edits, and close the Detail tab 
section of the Assignment List panel.  The tab at the bottom of the Assignment List 
panel indicating that the assignment is in Edit mode is removed.  Your 
assignment edits are reflected in the assignments list table in the panel.  Note that 
you can click the Refresh Assignment List option in the Tools menu at any time 
to update the assignment list table. 
 
Click Apply to update the assignment with your edits, and leave the Detail tab 
section of the Assignment List panel open for further review and edit.  Your edits 
up to the moment are reflected for the assignment in the assignment table in the 
upper portion of the panel.  Click Cancel to disregard current assignment edits.   

Unlock an Assignment 
If the Modeler or another Manager has an assignment opened in Edit mode, a lock is 
placed on the assignment.  This helps to prevent edit conflicts by an assignment being 
open for edits to two individuals simultaneously.   

1. If another user has an assignment opened in Edit mode, a window similar to the 
following displays to indicate who has the assignment open in Edit mode, and the 
time the assignment was locked. 
 

 
 
You have the option of viewing the assignment, or unlocking it.  Click OK to 
view the assignment only. 

2. To unlock the assignment, click Cancel, then select Unlock Assignment from the 
Tools menu.  The Unlock Assignment window displays. 
 

 
 
The user who has the assignment open for edit is listed for each locked 
assignment.  You can resize the window as desired, and also change the column 
order and size (column order and size settings are retained for future sessions).   
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3. Click the assignment you want to unlock to highlight it; the Unlock button 
becomes enabled.  
 

 
 
Click Unlock.  The following message window displays. 
 

   
4. Click OK to unlock the assignment and make it available for your own edits.  The 

user who initially had the assignment open for edit will not be able to save any 
edits that were not already updated.  That user must reopen the assignment in Edit 
mode in order to perform edits.  

Copy an Assignment 
If you want to create a new assignment that includes all, or most, of the items (i.e., 
concepts/terms for Modeler review and edit) in an existing assignment, you can copy the 
assignment items to a new assignment.  You then can specify a name and due date for the 
new assignment, and assign it to a Modeler. 

1. In the listing of assignments on the Assignment List panel, click the assignment 
you want to copy to highlight it, then click the Copy Assignment button in the 
Assignment List panel toolbar. 
 
 

 
 
The assignment items table in the lower portion of the panel reflects the items 
from the assignment you selected to copy.  None of the other details from the 
source (i.e., copy from) assignment is copied to the new assignment. 

Copy Assignment Button
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The indicator tab at the bottom of the panel specifies New Assignment.  

2. Enter a brief description of the new assignment in the Name field. 

3. In the Due Date field you can specify the expected completion date for the new 
assignment.  You can specify the due date in the format shown, or you can click 
the drop arrow adjacent to the field to display a calendar for date selection. 
 

 
 
Select the year and month from the appropriate field dropdown lists, then click the 
due date on the displayed calendar.  The date you select displays in the Due Date 
field on the Assignment List panel. 

4. From the Assigned To field dropdown list, select the DTS user to whom you are 
issuing the new assignment.  All established DTS users are included in the list 
(both Modelers and Managers).  Refer to the Managing DTS Users for Workflow 
discussions for procedures on creating and maintaining DTS users.  
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When you designate a Modeler or Manager for the assignment, the assignment 
status changes to ASSIGNED when you save the assignment.  If you do not 
select a Modeler, the assignment status remains as UNASSIGNED. 

5. You have the option of entering notes pertaining to the entire new assignment.  
Click the Notes tab, then click the New button that displays subsequently.  The 
Enter Notes window displays. 
 

 
 
Enter the note you want associated with the assignment, then click OK.  The note 
is listed in the display area on the Notes tab.  
 

 
6. Click the Details tab to redisplay the assignment detail information.   

7. Click OK.  The new assignment is added to the assignment list table in the top 
portion of the Assignment List panel.   
 

 
 
The Detail tab section of the Assignment List panel is closed, and the indicator tab 
at the bottom of the Assignment List panel indicating New Assignment is 
removed.  Note that you can click the Refresh Assignment List option in the 
Tools menu at any time to update the assignment list table.  
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Delete an Assignment 
You can delete an assignment only if it has never been accepted by a Modeler (i.e., you 
cannot delete an assignment with ACCEPTED status; the Delete button is disabled when 
a selected assignment cannot be deleted). 

1. In the listing of assignments on the Assignment List panel, click the assignment 
you want to delete to highlight it, then click the Delete Assignment button in the 
Assignment List panel toolbar. 
 
 

 

Delete Assignment Button 

2. A Confirmation window references the assignment number. 
 

 
3. Click OK.  The assignment is removed from the Assignment List panel table. 
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Disconnect From the DTS Editor 
Select Disconnect from the File menu, or click the toolbar Disconnect icon.  If there is 
unsaved data (new or modified) in one of the DTS Editor components, including one of 
the DTS Workflow tabs, a confirmation window similar to the following displays. 
 

 
Click Yes to close the component and disconnect without reviewing or updating unsaved 
data; displayed floating panels are closed when you disconnect.  Click Cancel to 
disregard the disconnect request. 
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DTS Workflow Modeler – Review Assignments/Perform Edits 
Both DTS Workflow Modelers and Managers can review any assignment.  For any 
assignment, a Manager can use the DTS Editor to perform edits driven by those 
assignments.  A Modeler can edit only those assignments that have been assigned to 
that Modeler).   

The DTS Editor Workflow functionality (i.e., Manager or Modeler) available to the login 
user depends on the workflow role assigned to the user.  Refer to the Assign Workflow 
Role to User discussion earlier in the guide.  Each DTS user also must have edit 
permissions established for the namespaces in which the edits will be performed.  Refer 
to the Create User/Assign Namespace Permissions discussion earlier in the guide. 

The following discussions pertain to functions available to a user with a DTS Modeler 
login.  Since a Workflow Manager also can perform these functions acting in the role of a 
Modeler, the discussions in this section are included in this guide to reference DTS 
Workflow from the Modeler’s perspective.  The Modeler can follow these procedures to 
review assignments and perform edits. 

View Modeler Assignments 
Follow this procedure to list assignments for the login Modeler (or a login Manager 
acting in the role of a Modeler) and to display details for a specific assignment. 
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1. Click the Assignment List tab on the DTS Editor Main window.  If you connected 
to the DTS Server with a Modeler login name, the Assignment List panel 
resembles the following.  
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When you click the Assignment List tab, the default Assignment List panel Filter 
is My Worklist.  Modeler assignments that are ASSIGNED, ACCEPTED, or 
REJECTED are listed when My Worklist is the filter.   

The following information is listed for each assignment when the Assignment List 
panel opens. 

ID – The assignment ID, created automatically by DTS Workflow when the 
Manager created the assignment 

Name – The assignment name (e.g., description) specified by the Manager on 
creation of the assignment 

Modeler – The username of the Modeler who will review the assignment items 
and perform necessary edits to concepts/terms in the assignment 

Manager – The current Manager of the assignment (i.e., the Manager who most 
recently assigned the assignment to a Modeler).  This Manager can be different 
from the one who created the assignment. 

Assigned – The date the Manager designated the assignment to the login Modeler 

Status – The current status of the assignment 

• UNASSIGNED – The Manager created the assignment, but did not select a 
Modeler to review or edit it   

o Only a Manager can create an assignment with UNASSIGNED status 

o Only a Manager can change an UNASSIGNED assignment to 
ASSIGNED  

• ASSIGNED – The Manager selected a Modeler to review the assignment and 
make required edits 

o Only a Manager can change an ASSIGNED assignment to 
UNASSIGNED, then assign it to another Modeler 

o A Modeler can change an ASSIGNED status to ACCEPTED (to agree to 
perform edits) or DECLINED (to decline to perform edits) 

• ACCEPTED – The Modeler has seen the assignment, and has accepted the 
tasks of reviewing the items within and making necessary edits  

o Only a Manager can change the ACCEPTED status to UNASSIGNED, 
then assign it to a different Modeler 

o A Modeler can change the ACCEPTED status to COMPLETED when 
all edits are finished, or to INCOMPLETE if only some edits could be 
completed 
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• DECLINED – The Modeler has seen the assignment, and has declined the 
task of reviewing the items within and making necessary edits.  A Manager 
can change the DECLINED status to UNASSIGNED, then assign the 
assignment to another Modeler. 

• INCOMPLETE – The Modeler has reviewed the items in the assignment and 
performed edits on some of them, but not all, and has marked the assignment 
as incomplete 

o Only a Manager can change an INCOMPLETE assignment to 
UNASSIGNED, then assign it to another Modeler 

o Only a Manager can change an INCOMPLETE assignment to 
REJECTED to reject the incomplete edits 

o Only a Manager can change an INCOMPLETE assignment to 
APPROVED to approve the edits 

• COMPLETED – The Modeler has reviewed the items in the assignment and 
performed all necessary edits, and has marked the assignment as complete 

o Only a Manager can change a COMPLETED assignment to 
UNASSIGNED, then assign it to another Modeler 

o Only a Manager can change a COMPLETED assignment to REJECTED 
to reject the edits 

o Only a Manager can change a COMPLETED assignment to 
APPROVED to approve the completed edits 

• REJECTED – The Manager has rejected the Modeler edits for a completed 
assignment 

o Only a Manager can change a REJECTED assignment to 
UNASSIGNED, then assign it to another Modeler 

o Only a Manager can change a REJECTED assignment to COMPLETED 
(e.g., if it was rejected accidentally) 

o Only a Manager can change a REJECTED assignment to 
INCOMPLETE (e.g., if it was rejected accidentally) 

o Only a Manager can change a REJECTED assignment to APPROVED 
to approve the completed edits 

o A Modeler can change a REJECTED assignment to ACCEPTED (to 
agree to perform edits) or DECLINED (to decline to perform edits) 
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• APPROVED – The Manager has approved the Modeler edits for a completed 
assignment 

o Only a Manager can change an APPROVED assignment to REJECTED 
(e.g., if it was approved accidentally) 

o Only a Manager can change an APPROVED assignment to 
COMPLETED (e.g., if it was approved accidentally) 

o Only a Manager can change an APPROVED assignment to 
INCOMPLETE (e.g., if it was approved accidentally) 

o Only a Manager can change an APPROVED assignment to 
UNASSIGNED, then assign it to another Modeler  for rework 
 
This illustration shows status edit privileges for Managers and Modelers. 
 

Modeler can
Accept or Decline
the assignment

Manager can assign
a new or existing
assignment  to a

Modeler

UNASSIGNED

ASSIGNED

DECLINED ACCEPTED

COMPLETE INCOMPLETE

APPROVEDREJECTED

Modeler can mark
the assignment as

Complete, or
Incomplete

Manager can Approve
assignment edits, or
mark assignment as

Rejected

Manager can reset
Incomplete, Accepted,  or
Approved assignment to

UnassignedManager can reset
Complete or Rejected

assignment to
Unassigned

 

Status Date – The date the assignment status last changed 

Created By – The Manager who created the assignment 

Created – The date the assignment was created by the Manager 

Due – The date the Manager expects completion of the assignment by the 
designated Modeler.  If the Manager did not specify a due date for the assignment, 
the assignment creation date is the default 

Modified – The date the assignment was last modified (whether or not the 
assignment status changed as a result of the modification) 
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Filter Assignment List 
To filter the list to view only those assignments that interest you, click the Filter field 
dropdown arrow.  The filter options are listed. 

• My Worklist - Assignments assigned to the Modeler that are ASSIGNED, 
ACCEPTED, or REJECTED 

• My Assignments - Assignments created for the Modeler that are not 
APPROVED 

• All Approved - All assignments with APPROVED status 

• All - All assignments (no filter) 

Customize Assignment List Table Layout  

2. You can reposition the Assignment List table columns by dragging/dropping the 
column headers into their new positions.  You also can resize each column, as 
needed (note the illustration).     
 

        
 
You can resort the table data by clicking the desired (sort) header once.  The first 
click sorts the table in ascending order; the second click sorts in descending 
order.  Click the column header a third time to remove the sort.  Establish a 
secondary sort by pressing the Control key, then clicking the secondary column. 

View Assignment Detail 

3. In the assignment list, click the assignment to highlight it, then click the View 
Assignment button in the Assignment List panel toolbar. 
 
 
 

 
  
The lower portion of the panel displays details for the assignment you selected. 
 

View Assignment Button 
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The tab at the bottom of the Assignment List panel indicates the number of the 
assignment, and also that the assignment is in View mode.  
 
None of the assignment detail is editable in View mode (all fields are disabled for 
edit).  Click the Edit Assignment button to perform edits on the selected concept. 
 
The following assignment detail is listed in View mode. 

• Name – A brief description of the assignment, entered by the Manager 
when the assignment was created, or modified subsequently by a Manager 

• Due Date – The expected completion date for the assignment, entered by 
the Manager when the assignment was created, or modified subsequently 
by a Manager 

• Assigned To – The DTS user (i.e., Modeler or Manager) to whom the 
Manager issued this assignment either when the assignment was created, 
or when the assignment was modified subsequently by a Manager   

• Status – The current status of the assignment 

• Created – The date the Manager created the assignment 

• Assigned By – The Manager who specified the assignment Modeler (this 
can be a Manager other than the one who created the assignment) 

4. Ensure the Details tab is selected to display assignment detail information.  
Assignment items are listed in table format in the lower portion of the panel.   
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The following detail is included for each concept/term item in the assignment. 

• Complete – If the checkbox is checked, it indicates that a Modeler has 
reviewed this individual item, completed necessary edits, and marked the 
individual item as COMPLETE 

• Type – The type of namespace item for review and/or edit by the Modeler, 
Concept or Term 

• Name – The name of the concept or term the Manager selected for 
Modeler review or edit 

• ID – The concept or term ID 

• Code – The concept or term code 

• Namespace – The namespace from which the Manager selected the 
concept or term to be reviewed/edited; concepts/terms from multiple 
namespaces can be included in the same assignment.  Assignment edits to 
subscription namespaces are written to the local namespace selected by the 
Modeler in the DTS Editor.  

• Added By – The Manager who added the concept/term item (this can be a 
Manager other than the one who created the assignment) 

• Notes – The Manager can enter a note (e.g., review or edit instructions) 
for each individual concept/term item in the assignment when the 
assignment is created; any Manager can enter notes for individual items 
during subsequent edit of the assignment 

You can resort the item data by clicking the desired (sort) header once.  The first 
click sorts the table in ascending order; the second click sorts in descending 
order.  Click the column header a third time to remove the sort.  Establish a 
secondary sort by pressing the Control key, then clicking the secondary column. 
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5. The Manager who creates the assignment has the option to create notes regarding 
the assignment.  Any Manager also may enter additional notes after the 
assignment is created (i.e., when the assignment is opened in Edit mode).  In 
addition, the Modeler to whom the assignment is assigned also can add notes.   
 
To view notes related to the entire assignment, click the Notes tab.  All notes 
entered for the assignment are listed in the notes display area. 
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In addition to the note text, each note includes the date and time the note was 
created.  You can restrict the display to a single note for the assignment by 
selecting the username and time stamp for the note from the Note By field 
dropdown list.  

6. Click the Details tab to redisplay the assignment detail.  

7. Click Close to close the detail portion of the Assignment List panel.   
This indicator tab (View Assignment #nn) remains displayed in the bottom 
portion of the window until you close the assignment view. 
 
At this point you can select another assignment from the Assignment List panel 
table, or click any other indicator tab (View Assignment, Edit Assignment, etc.) 
at the bottom of the display to resume that function.  

Perform Edits From Modeler Assignments 
Follow this procedure to view the concept/term on an assignment line item, and perform 
any necessary edits for the concept/term. 

1. In the assignment list, double-click the assignment for which you want to view 
details and perform edits.  Or, click the assignment to highlight it, then click the 
Edit Assignment button in the Assignment List panel toolbar. 
 
 
 

 
 
An alternate method for opening the assignment in Edit mode is to select Go To 
Assignment from the Tools menu (Note: if the assignment is APPROVED, it 
will open in View mode).  The following window displays. 
 

 
 
Enter the number of the assignment you want to edit, then click OK.  The lower 
portion of the panel displays details for the assignment you selected. 
 

Edit Assignment Button 
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The tab at the bottom of the Assignment List panel indicates the number of the 
assignment, and also that the assignment is in Edit mode.  In the detail portion of 
the panel, the Name Due Date, and Status of the assignment are listed.  Also listed 
is the date the assignment was Created, as well as the Manager who created the 
assignment (in the Assigned By field).  These fields are for reference only.  

2. From the Status field dropdown list, select ACCEPTED.  You should change the 
assignment status from ASSIGNED to ACCEPTED before you perform edits.  

3. Select a concept or term from one of the line items, then drop the concept into the 
Concept/Term Details panel.  To enable the Click to Edit feature, right-click 
anywhere on the individual item, then select Click to Edit from the listed options. 
 

 
 
As long as Click to Edit is enabled, any concept or term you click in an 
assignment line item displays automatically in the Concept/Term Details panel.  
This eliminates the need to drag the selected concept to the Concept/Term Details 
panel for view or edit. 
 
After you select a concept or term from one of the line assignment line items, 
details for the selected concept/term display in the Concept/Term Details panel. 
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4. At this point you can use the standard view and edit capabilities in the DTS Editor 

to perform the required concept/term changes in the Concept/Term Details panel.  
Edits you make to a subscription (i.e., non-editable) namespace will be reflected 
in the local namespace that is current at the time the subscription edit is made.  
Refer to the Set Current Local Namespace and Concept Maintenance discussions 
in the DTS Editor Users Guide for procedures on editing concepts and terms.  
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5. If edits are completed for an individual assignment item, you can update the status 
of each individual item in the assignment item table as COMPLETE.  Click the 
Apply button to update the assignment as ACCEPTED, then click the Complete 
checkbox for the assignment item. 
 

 
 
You also can right-click anywhere on the individual item, then click Mark 
Complete when the resulting options display to update the item status as 
COMPLETE.  A check mark is inserted in the Complete checkbox. 
 

 
Multiple Selection Feature 
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If the Multiple Selection feature is enabled, you can select multiple lines for 
update to COMPLETE status.  A check mark is inserted in the Complete 
checkbox for each of the selected items. 
 
If one or more completed assignment items require additional review or edit, click 
Mark Incomplete for the highlighted items.  If the Multiple Selection feature is 
enabled, use the standard Windows selection procedures to select and highlight the 
lines.  The following window displays.   
 

 
 
Click OK.  The check mark is removed from the Complete checkbox for the 
selected item(s).  Note that you can update the status of the entire assignment as 
COMPLETED, even if one or more of the individual line items is marked 
Incomplete. 

6. A Modeler can delete only items that he/she has added (not items assigned by a 
Manager).  To delete one or more items (whether marked as completed or not) 
with Multiple Selection enabled, use the standard Windows selection procedures 
to select and highlight the desired lines, then right-click on one of the lines.   
 

 
 
Click Delete when the options list displays (the Delete option is disabled if the 
item was not added by the Modeler).  The following window displays   
 

 
 
Click OK to confirm deletion of the item(s) from the assignment. 

Delete 

7. You have the option to create notes regarding the entire assignment.  Click the 
Notes tab, then click the New button that displays subsequently.  The Enter Notes 
window displays. 
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Enter the new note you want associated with the assignment, then click OK.  The 
new note is listed in the display area on the Notes tab.  
 
Click the Details tab to redisplay the assignment detail information.   

8. You also can enter note text for each individual concept/term item in the 
assignment (e.g., details regarding the edits performed).  To enter note text for a 
line item, enter the desired text in the Notes column field on the desired line. 
 

 

Update Assignment as Complete or Incomplete 
9. Click Apply to update the (entire) assignment with your edits, and leave the 

Detail tab section of the Assignment List panel open for further review and edit.  
Your edits up to the moment are reflected for the assignment in the assignments 
list on the panel. 

10. From the Status field dropdown list, select COMPLETE.  This indicates to the 
Workflow Manager that all possible reviews and edits of the assignment line 
items have been completed.   
 
Note that you can update the status of the entire assignment as COMPLETED, 
even if one or more of the individual line items is not marked as Complete.  The 
following confirmation window displays. 
 

 
 
Click OK to update the assignment status as COMPLETED.  Select 
INCOMPLETE to indicate to the Workflow Manager that you reviewed the 
assignment (and possibly made edits) but that the assignment may need further 
review and additional edits.  You can update the status of the entire assignment as 
INCOMPLETE, even if all of the individual line items are marked as Complete. 
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Click OK to update the assignment with your status edit, and to close the Detail 
tab section of the Assignment List panel.  The tab at the bottom of the Assignment 
List panel indicating that the assignment is in Edit mode is removed.   
 
Your assignment edits are reflected in the assignments list table in the panel.  
Note that you can click the Refresh Assignment List option in the Tools menu at 
any time to update the assignment list table.  

Add New Concepts/Terms to an Assignment 
An assignment may require that you create one or more new concepts or terms.  You 
create new concepts/terms using the standard procedure in the DTS Editor Concept/Term 
Details panel.  You have the option to add each new concept/term as an assignment item.  
This provides an audit trail of the creation of the concept/term in the database.   

You have two options for adding a new concept/term to an assignment.  The first option 
allows you to add each new concept/term as an assignment item as you create it.  The 
other option allows you to view all new concepts/terms created by you (for all 
assignments) then select the concepts/terms to add as assignment items. 

Add New Concepts/Terms as You Create Them  

Follow this procedure to selectively accept or decline addition of new concepts/terms as 
assignment items.  

1. Select the assignment for which you want to add new concepts/terms. 

2. After you click New in the Concept/Term Details panel, you are prompted to 
specify the new concept/term Name.  
 

   
 
Specify the concept/term name, then click OK.   The Add Assignment Item 
window displays. 
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You have four options for adding to the assignment the concept/term you are 
creating currently, as well as any concepts/terms you create subsequently. 

3. Click the desired option for adding new concepts/terms to this specific 
assignment.  If you select another assignment and attempt to add new 
concepts/terms, you are prompted again for parameters to add new the 
concepts/terms as assignment items. 

• Click Yes to add this new concept/term as an assignment item.  The Add 
Assignment Item window displays for each subsequent concept/term you 
create for this assignment; this allows you to selectively add a new 
concept/term as you create it, or decline the addition.  

• Click Yes To All to add this new concept/term, and all subsequent 
concepts/terms you create, as assignment items.  The Add Assignment Item 
window does not display for each new concept/term you create for the current 
assignment (i.e., additional concepts/terms are added as assignment items 
without confirmation of each added item).  

• Click No if this specific new concept/term should not be added as an 
assignment item.  The Add Assignment Item window displays for each 
subsequent new concept/term you create for this assignment; this allows you 
to selectively add a new concept/term as you create it, or decline the addition. 

• Click No To All to decline addition of this new concept/term, and all 
subsequent concepts/terms you create, as assignment items.  The Add 
Assignment Item window does not display for each new concept/term you 
create for the current assignment (i.e., additional concepts/terms are not added 
as assignment items, and no confirmation is requested).  

Based on your option selection for adding new assignment items for new 
concepts/terms, the Assignment List panel items detail is updated.  Note the three 
new items in the bottom of the table, each referencing a new concept added to a 
local Namespace by the Modeler (under Added By). 
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Select New Concepts/Terms From Across Assignments After You Create Them 

Follow this procedure to select one or more new concepts/terms to add to an assignment 
after you complete creation of those concepts/terms.  All new concepts/terms created by 
you, for all assignments, are available for selection and addition to the current 
assignment. 

1. Add new concepts/terms for assignments using the standard DTS Editor 
Concept/Term Details panel procedures. 

2. Right click in the Assignment List panel items table.  From the displayed options, 
select Add New Concept/Term. 
 

 

Add New 
Concept/ 
Term 

3. The following window displays. 
 

 
 
Click OK if you want to select concepts/terms you have created for addition to 
this assignment.  

The Add New Items window displays, listing all concepts/terms created by you.  
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You can resize the Add New Item panel as desired.  You also can resize and 
reposition the columns in the table; these sizing and positioning parameters are 
retained for future sessions.  

4. When you have determined which concepts/terms to select, use standard Windows 
selection procedures to highlight the lines, then click Add.  
 

 
The concepts/terms you selected are added to the Assignment List panel items 
detail.  Note the two new items in the bottom of the table, each referencing a new 
concept added (in this case, to a local namespace).    
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Audit Queries 
When a Modeler or Manager edits a concept or term in a namespace (edits driven by one 
or more assignments) an audit history is created for the concept/term.  The DTS 
Workflow application includes an Audit Query feature that allows Modelers and 
Managers to search the audit history for these edits.  A series of search filters allows you 
to specify which edit transactions should be returned from each query.  

Multiple versions of a concept/term result if edits were performed at different times, and 
the concept/term edits were saved more than once.  If the audit history search returns 
multiple concept/term versions, you can compare the details of each version.  This may 
help you to determine if all edits were appropriate, and if additional edits are needed.  

For Workflow Managers (only) DTS Workflow also provides an audit history for each 
assignment.  The history is created when the assignment is created, and then is updated 
when the assignment status changes.   

Search Audit History for Concept/Term Edits 
Follow this procedure to enter criteria by which to search for concept/term edits that were 
driven by assignments. 

1. Select Audit from the DTS Editor Main window tab options.  The Audit panel 
displays as illustrated. 
 

 
 
You can resize the Audit panel, as desired.  Note the illustration. 
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2. You have the option of filtering history items returned from the query.  Select the 

value by which to filter the query from the Filter By field dropdown list (use the 
default, None, if you do not want results filtered).  Each filter option is discussed. 

Namespace Name – Only edits from the namespace you select from the 
dropdown list are returned. 

 
 
User – Only edits performed by the user you select from the dropdown list are 
returned.  Only active users are listed; to search for an inactive user (i.e., a user 
deleted using the Apelon DTS User Manager), enter the complete username.   

 
 
Concept Id – Only edits for concepts with IDs in the range you specify are   
returned.  Specify the opening and closing ends of the search range in the From 
and to fields, respectively.  You can drag an ID for a concept displayed in the 
Concept/Term Details panel, and drop it as either of the concept IDs in the search 
range.   
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Concept Code – Only edits for the concept with a (case-insensitive) code that 
matches the one you specify are returned.  Note that you may use wildcards (*) in 
your concept code search string.  You also can drag the code from a concept 
displayed in the Concept/Term Details panel, and drop it as the code for search.   

 
 
Concept Name – Only edits for the concept with a (case-insensitive) name that 
matches the one you specify are returned.  Note that you may use wildcards (*) in 
your concept name search string.  You also can drag the name for a concept 
displayed in the Concept/Term Details panel, or another displayed panel, and drop 
it as the name for search 

 
 
Term Id – Only edits for terms with IDs in the range you specify are   
returned.  Specify the opening and closing ends of the  search range in the From 
and to fields, respectively.  You can drag an ID for a term displayed in the 
Concept/Term Details panel, and drop it as either of the term IDs in the search 
range.     

 
 
Term Code – Only edits for the term with a (case-insensitive) code that matches 
the one you specify are returned.  Note that you may use wildcards (*) in your 
term code search string.  You also can drag a code from a term displayed in the 
Concept/Term Details panel, and drop it as the term code for search.      

 
 
Term Name – Only edits for the term with a (case-insensitive) name that matches 
the one you specify are returned.  Note that you may use wildcards (*) in your 
term name search string.  You also can drag the name for a term displayed in the 
Concept/Term Details panel, or another displayed panel, and drop it as the term 
name for search.     
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Assignment Id – Only edits from assignments with IDs in the range you specify 
are returned.  Specify the opening and closing ends of the range in the From and 
to fields, respectively.  

 
 
Assignment Name – Only edits from the assignment with a (case-insensitive) 
name that matches the one you specify are returned.  Note that you may use 
wildcards (*) in your assignment name search string.    

 
3. You can further filter the query to retrieve only history items from within the date 

range you specify.  You have two options for specifying the date range.  To 
retrieve history items within the last 0-30 days, click the Show last field button, 
then select the number of days using the buttons provided (7 is the default).     
 

  
 
The other option is to click the Show from field button, then designate the opening 
and closing ends of the query date range.  The default is a one-week date range, as 
shown in the illustration.   
 

 
To establish an opening date in the query range that is earlier than one week ago, 
you can type in a date in the Show from field in the format shown.  You also can 
click the arrow in the Show from field to display a calendar for selection. 
 

 
 
Select the year, month, and the opening date in the query date range (the default 
date selected is 7 days prior to the current date) then select the closing year, 
month, and date in the range (the default closing date is today’s date).  Both the 
opening and closing date value times are 12:00 AM. 
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After you enter all parameters, click Search.  Audit history entries that meet your 
search criteria are retrieved and listed in table format.   
 
The following column data displays.  You can resize and reposition the columns 
in the table.  

• Namespace - The namespace in which the edit occurred 

• Type - The type is Concept or Term 

• Name - The name of the concept or term 

• ID - The concept or term ID 

• Code - The concept or term code 

• Version - Each time a concept/term is edited and saved, that version of 
the concept/term is saved to a table in the database.  If edits to a 
concept/term are saved multiple times, this results in multiple versions 
of the concept/term.  Each version is listed in the table (provided it 
meets your search criteria).  Refer to the Viewing Concept/Term 
Versions discussion for instructions on viewing different versions. 

• User - The user who performed the edit 

• Date - The date and time the edit occurred 

• Asgmt ID - The ID of the assignment for which the edit occurred.  In 
the illustration, the first three concept edits listed do not reference an 
assignment ID, indicating that these edits were not driven by 
assignments (i.e., they were unassigned edits).  Each remaining listed 
edit references an assignment ID, indicating that each was driven by an 
assignment. 
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• Asgmt Named - The name of the assignment for which the edit 
occurred.  In the illustration, the first three concept edits listed do not 
reference an assignment name, indicating that these edits were not 
driven by assignments (i.e., they were unassigned edits).  Each 
remaining listed edit references an assignment name, indicating that 
each was driven by an assignment. 

• Edit Type - The type of edit that occurred, Add, Update, or Delete  

• Attribute Type - The attribute (e.g., Property, Association, etc.) that 
was added, updated, or deleted 

• Changes From Last Version - If you check the Show Changes field 
checkbox, the Changes From Last Version column indicates the edit 
that was made to the previous version of the concept or term (i.e., the 
difference between the two versions is noted).   
 

 
 
This feature is useful when assignment edits result in concept changes 
to associations; changes are listed for all concepts affected by the 
assignment edit (both target and source concepts).   
 
The feature also is useful when assignment edits result in multiple 
saved edits to a concept or term, producing multiple versions of the 
concept or term.  Viewing the change referenced in the Changes 
From Last Version column from the previous version may help you 
to select the version of the concept or term for which you want to see 
details.  Refer to the Viewing Concept/Term Versions discussion 
(which follows this discussion) for more on viewing details from 
multiple versions.  
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Viewing Concept/Term Versions 
If assignment edits to a concept/term were saved more than once, this results in multiple 
versions of the concept/term.  You can view the details of each specific version of the 
concept/term, which may help you determine if an edit from a previous version is 
preferable to the current concept/term version. 

1. Click Search on the Audit panel to retrieve audit history entries that meet your 
search criteria.  Results are listed in the query results table; in the illustration, four 
versions are listed for the concept Chronic dermatitis (disorder).  
 

 
2. Drag each version for which you want to see details into one of the Version panes 

below the table.  In the illustration, versions 2 and 4 of the concept were dragged 
into the detail panes.  You can resize the Version panes, as needed. 
 

 
 
Each Version pane reflects the state of the concept/term as the result of an 
edit/update cycle. 
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Assignment Audit Panel 
As a result of viewing audit search results, you may want to see more detail regarding a 
specific assignment referenced in the audit results table.  DTS Workflow makes available 
an audit history for each assignment (the assignment audit is available to Workflow 
Managers only).  The history is created when the assignment is created, and is updated 
when the assignment status changes, and when an item is added to or deleted from the 
assignment. 

1. Select Assignment Audit from the DTS Editor Main window Tools menu.  The 
Assignment Audit window displays. 
 

 
2. Enter the number of the assignment for which you want to review detail in the 

Assignment ID field, then click Find.  History data for the assignment is listed in 
table format. 
 

  
 
The following column data is provided. 
 
   User – The user who generated the audit history item 
   Created – The date the audit history item was created 
   Text – A brief description of the audit item transaction.  If an assignment item   
    is added or deleted, the description references the assignment concept, as well   
   as the namespace in which the concept/term resides.   
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You can resize the Assignment Audit panel as desired.  You also can resize and 
reposition the columns in the table.  The column position and sizing parameters 
are retained for future sessions.  
 
You can resort the table data by clicking the desired (sort) header once.  The first 
click sorts the table in ascending order; the second click sorts in descending 
order.  Click the column header a third time to remove the sort.  You can establish 
a secondary sort by pressing the Control key, then clicking the secondary sort 
column.    
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Disconnect From the DTS Editor 
Select Disconnect from the File menu, or click the toolbar Disconnect icon.  If there is 
unsaved data (new or modified) in one of the DTS Editor components, including one of 
the DTS Workflow tabs, a confirmation window similar to the following displays. 
 

 
Click Yes to close the component and disconnect without reviewing or updating unsaved 
data; displayed floating panels are closed when you disconnect.  Click Cancel to 
disregard the disconnect request. 

 

Back to Top
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